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FOREWORD

Scope and Intended Audience

Scope. This publication describes how to install, configure, administer and use 
the Avamar NDMP Accelerator (accelerator) to back up and restore supported EMC 
Celerra IP storage systems and NetApp filers.

NOTE:  For the sake of clarity, this publication often uses the
term “storage device” to generically refer to any supported
data filer, file server or IP storage system.

Intended Audience. The information in this publication is primarily intended for 
system administrators who are responsible for installing software and maintaining 
servers and clients on a network.

Prerequisites. Persons using this publication should have current practical 
experience with:

• Network Data Management Protocol (NDMP)
• Supported EMC Celerra IP storage systems or NetApp filers currently deployed 

at your site
• Unix shell scripts

Product Information
For current documentation, release notes, software updates, information about 
EMC products, licensing and service, go to the EMC Powerlink website at 
http://Powerlink.EMC.com.
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 Typeface Conventions
FOREWORD
Your Comments
Your suggestions will help us continue to improve the accuracy, organization and 
overall quality of our publications. You may email your comments to:

BSGDocumentation@emc.com

Please include the following information:

• Product name and version
• Document name, part number, and revision (for example, A01)
• Page numbers
• Other details that will help us address the documentation issue

Typeface Conventions
The following table provides examples of standard typeface styles used in this 
publication to convey various kinds of information.

EXAMPLE DESCRIPTION

Click OK.
 or
Select File > Close.

Bold text denotes actual buttons, commands, 
menus and options that initiate action.
Sequential commands are separated by a greater-
than (>) character. For example, the second 
example instructs you to select the Close 
command from the File menu.

Type:
 cd /tmp

Bold fixed-width text denotes shell commands that 
must be entered exactly as they appear.

--logfile=FILE All caps text often denotes a placeholder (token) 
for an actual value that must be supplied by the 
user. In this example, FILE would be an actual 
filename. 

Installation Complete. Regular (not bold) fixed-width text denotes 
command shell messages, code and file contents.
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 Notes, Tips, and Warnings
FOREWORD
Notes, Tips, and Warnings
The following kinds of notes, tips, and warnings appear in this publication:

IMPORTANT:  This is a warning. Warnings always contain
information that if not heeded could result in unpredictable
system behavior or loss of data. 

TIP:  This is a tip. Tips present optional information intended
to improve your productivity or otherwise enhance your
experience with the product. Tips never contain information
that will cause a failure if ignored.

NOTE:  This is a general note. Notes contain ancillary infor-
mation intended to clarify a topic or procedure. Notes never
contain information that will cause a failure if ignored.
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INTRODUCTION

The Avamar NDMP Accelerator (accelerator) is a dedicated single-node Avamar 
client that, when used as part of an Avamar system, provides a complete backup 
and recovery solution for supported EMC Celerra IP storage systems and NetApp 
filers by using Network Data Management Protocol (NDMP) to communicate with 
these storage devices.

NOTE:  For the sake of clarity, this publication often uses the
term “storage device” to generically refer to any supported
EMC Celerra IP storage system or NetApp filer.

Functional Overview
Avamar NDMP Accelerator uses the standard Network Data Management Protocol 
(NDMP) as well as published extensions of the NDMPcopy utility.

Data from the storage device is not stored on the accelerator. The accelerator 
performs NDMP processing, real-time data de-duplication, then forwards that data 
to the Avamar server. Due to the inherent advantages of data de-duplication, you 
can locate the accelerator either locally (LAN) or remotely (WAN) with respect to 
the Avamar server. However, in order to ensure acceptable performance, the 

LAN/WANLAN
Print Server

Link/Rx LPT1 LPT2 COMPower/TX

STORAGE 
DEVICE-1

AVAMAR NDMP 
ACCELERATOR

AVAMAR SERVER

STORAGE 
DEVICE-2
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 General Capabilities and Limitations
INTRODUCTION
accelerator must be located on the same Local Area Network (LAN) as the storage 
device being protected. 

The Avamar NDMP Accelerator is a full peer to other Avamar clients (for example, 
Avamar Linux Clients, Avamar Windows Clients, and so forth) with one exception: 
whereas the Avamar Administrator graphical management console can be used to 
browse the live filesystems of most other clients, it cannot browse the live 
filesystem of storage devices.

Supported Configurations
The Avamar NDMP Accelerator supports the following configurations:

General Capabilities and Limitations
This topic discusses general capabilities and limitations of the Avamar NDMP 
Accelerator. 

Avamar NDMP Accelerator Configuration and Setup. Instructions for 
configuring and setting your Avamar NDMP Accelerator are beyond the scope of 
this publication. Refer to your Avamar System Installation Manual for detailed 
Avamar NDMP Accelerator configuration and setup instructions.

Full Support for NDMP Version 4. Beginning with Avamar 5.0, the Avamar 
NDMP Accelerator fully supports NDMP version 4.

Full Support for Storage Device ACLs and Q-tree Data. The accelerator can 
protect and restore all storage device accounting information and Access Control 
Lists (ACLs). The use of NDMP is the only method to protect the metadata 
associated with both user files and the storage device itself.

Support for Multiple Storage Devices Using One Accelerator. A single 
accelerator can support more than one storage device. However, by default you 
will still be limited to running one backup at a time. 

For example, consider two storage devices (storage device-1 and storage device-
2), which are registered to the same accelerator. Both storage devices are backed 
up by using scheduled group backups and both storage devices belong to the 
same group.

COMPONENT

SUPPORTED VERSION(S)

EMC CELERRA NETAPP

Storage 
Devices

DART 5.6 or 5.5 with I18N 
enabled.

Data ONTAP 7.3, 7.2 or 7.1.

Networking • 100baseT or 1000baseT connection required between 
storage device and the accelerator

• Either LAN or WAN connection supported between the 
accelerator and the Avamar server
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 General Capabilities and Limitations
INTRODUCTION
When the scheduled group backups are initiated, storage device-1 will begin 
backing up immediately; storage device-2’s backup job will be queued until 
storage device-1’s job completes. 

IMPORTANT:  If you want to backup multiple storage
devices simultaneously, you must specifically configure your
accelerator to do this (page 10).

Support for Multiple Backup Streams From a Single Storage Device. If 
you have configured your accelerator to support multiple backups (page 10), you 
can use this feature to add more than one stream from the same storage device. 
In most cases, this will result in improved backup throughput from the same 
storage device.

In order to do this, run the avsetupndmp script (page 29) and add more than one 
instance of the same storage device. When you set up scheduling for your storage 
device backups (page 48), be sure to add all storage device instances to the 
Avamar group.

For best performance, you should also add additional system RAM.

Support for Multiple Simultaneous Backups. A single accelerator can 
support multiple simultaneous backups. This requires additional system RAM. 

IMPORTANT:  Support for multiple simultaneous backups
requires 8 GB of RAM or greater (4 GB per client instance,
with a maximum of 4 client instances per accelerator), and
the use of the appropriate operating system kernel for the
amount of RAM installed.

With this option enabled, up to four backups can run simultaneously, provided that 
all were initiated as scheduled group backups (on-demand backups run one at a 
time). 

Number of Bytes Reported by Avamar for Small Backups. The number of 
bytes that Avamar reports for small NDMP backups may be off by a small amount 
(a few kilobytes). This behavior is normal. The NDMP device adds a small amount 
of “housekeeping” data to the backup.

Data Backed Up on Other Avamar Client Types Cannot Be Restored to a
Storage Device. Volumes, directories and files that are included in a backup 

performed by other Avamar client types are fully browsable by Avamar 
Administrator. However, these entities cannot be restored to a storage device.

Avamar NDMP Accelerator Cannot Be Configured Using Avamar Adminis-
trator. Configuration of an Avamar NDMP Accelerator is performed using the 

avsetupndmp script. It is not possible to modify any accelerator settings using 
Avamar Administrator.

Browsing Directories and Files Is Not Supported. When browsing a storage 
device filesystem for purposes of creating a dataset or performing an on-demand 
backup, only volumes will be visible. You cannot browse into volumes and view 
individual directories or files.
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 EMC Celerra Capabilities and Limitations
INTRODUCTION
Include/Exclude Not Supported. Dataset include or exclude rules cannot be 
used when performing an NDMP backup.

No Control of Overwrite Options on Restore. None of the overwrite and 
open file options are applicable when performing an NDMP restore. NDMP 
implicitly always overwrites existing files when restoring.

Web Restore with External Authentication Not Supported. Data from an 
NDMP backup cannot be restored with Avamar Web services by an externally 
authenticated user.

User and Group Names Not Displayed. When listing the contents of a backup 
the users and groups are displayed as their numbers instead of their names.

Cannot Use Wildcards When Selecting Files to Backup. Wildcard 
characters cannot be used when specifying volumes or directories to be backed-
up. This is an NDMP limitation.

Cancelling Backups Might Take Several Minutes. Due to the behavior of 
some storage devices, cancelling an NDMP backup might take several (typically 
3–5) minutes.

Environment Variables Not Supported. Avamar does not permit you to set 
arbitrary NDMP environment variables when defining a dataset or performing on-
demand backups and restores.

Passwords Cannot Contain Single-Quotes. During installation and 
configuration of the Avamar NDMP Accelerator for use with your storage device, 
the avsetupndmp script asks for an NDMP user account password. This password 
cannot contain single-quotes.

I18N Characters Might Not Display Properly in
 Avamar Administrator. Some international (I18N) characters in file and 

directory names might not render correctly in Avamar Administrator. However, 
this does not affect the ability to actually restore them. 

Restore Limitations. Only one volume can be restored at a time.

EMC Celerra Capabilities and Limitations
This topic discusses capabilities and limitations of the Avamar NDMP Accelerator 
that are specific to integrating with EMC Celerra IP storage systems.

Backward Compatibility With Pre-5.0 Avamar Servers. For best results, 
you should use a version 5.0 accelerator with a version 5.0 Avamar server. 
However, if you must use a version 5.0 accelerator with an earlier version Avamar 
server, the following limitation applies: 

EMC Celerra backups stored on an Avamar 4.1 or earlier server cannot be used to 
restore more than one individual file in the same restore operation. Multiple 
restore operations must be used to restore several individual files.
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 EMC Celerra Capabilities and Limitations
INTRODUCTION
Restoring a Directory to Celerra Includes the Directory File. Beginning 
with Avamar 5.0, restoring a single directory includes all files as well as the 
directory file. Previously, Avamar NDMP Accelerator restored only the files within 
the directory. The directory file itself was not restored.

Incremental Backups Should Only Be Performed at the Volume
 Level. For best results, always perform incremental backups at the volume 

level. For Celerra, Avamar will default to performing full backups of lower level 
directories and subdirectories. However, it is possible to override this default 
behavior and force an incremental backup of lower level directories and 
subdirectories. This is not a good practice as it can cause unpredictable application 
behavior.

Sub-Volume Backups Always Level-0. Any sub-volume (that is, non-root) 
backups of Celerra always use Level-0 backups. If the Prefer Incremental, but do a 
Full if required plugin option is selected, a level 0 backup is performed. If the 
Force and incremental (level 1) dump plugin option is selected, a level 1 backup is 
performed. The level 1 backup may report an error.

Multiple Backup Stream Limitation. EMC Celerra IP storage systems are 
limited to a maximum of 4 simultaneous backup streams.

Avoid Including Certain Unix Hardlinks in Incremental Backups. Some 
Unix hardlinks with non-ASCII characters in the name might not be tracked 
correctly during incremental backups of Celerra. It is best to exclude these 
hardlinks from incremental backups. If this is not possible, use Level-0 backups 
instead.

Path Length Limitations. EMC Celerra IP storage systems impose a maximum 
path length limit of 1023 characters. However, the known practical limit for 
specifying paths in Avamar is only 976 characters. Therefore, you cannot specify 
paths greater than 976 characters at any time.

Additionally, during restores, the total path length when specifying a directory is 
limited to 255 characters.

File Size Limitation. The size of a backup from a Celerra storage device differs 
from the actual size of the on-disk data. For example, the size of a backup from a 
Celerra storage device shows the size of the deduplicated disk, not the actual file 
size. Avamar Administrator shows size statistics for completed backups in the 
Activity window on the Activity Monitor tab.

Maximum Number of Files Limitation. Each individual Avamar backup can 
contain a maximum of 10 million files.

Incremental Backup Limitation. An incremental backup that includes too 
many files to back up might fail due to memory limitations.
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NetApp Capabilities and Limitations
This topic discusses capabilities and limitations of the Avamar NDMP Accelerator 
that are specific to integrating with NetApp filers.

Backward Compatibility With Pre-5.0 Avamar Servers. For best results, 
you should use a version 5.0 accelerator with a version 5.0 Avamar server. 
However, if you must use a version 5.0 accelerator with an earlier version Avamar 
server, the following limitations apply: 

NetApp backups taken with a version 5.0 accelerator are not compatible with 
older Avamar backups. Therefore, the first time a filer is backed up with a 
version 5.0 accelerator, a full backup is automatically taken (forced). Version 
5.0 accelerators are able to restore from pre-5.0 backups with no limitations. 

Furthermore, in order to perform backups and restores with an Avamar 4.1 
server, version 5.0 dpnavclient RPM must be installed on the server’s utility 
node.

NetApp backups taken with a version 5.0 accelerator cannot currently be 
stored on pre-4.1 Avamar servers.

Support for Backup and Restore of Volumes, Q-trees and
 Directories. The accelerator is capable of performing backups and restores at 

the volume, q-tree or directory levels. Selection of any entity type other than a 
volume (q-tree, directory) must be done by typing the path to that entity within 
the volume.

Only One Target Volume or Directory per Backup or Restore. Each 
individual Avamar backup or restore can only comprise one target storage device 
volume or directory. Selection of multiple source directories or files is not 
permitted.

Backing Up Empty Directories. Avamar reports one to a few kilobytes for a 
backup of an empty directory. The actual number of kilobytes reported depends 
on the number of empty files. This behavior applies only to a NetApp filer. The 
same backup on Celerra correctly reports 0 KB.

Extra “restore_symboltable” File Written During Restores from NetApp
filers. When restoring from a NetApp filer, an extra file “restore_symboltable” 

is created on the restore target. This file is created by the NetApp filer (not 
Avamar software) and is a known limitation of restoring from a NetApp filer. Refer 
to NetApp Bug ID 30347 for additional information. Note also that if the dataset 
used for backups already contains a “restore_symboltable” file that it will be 
renamed to “rstabRENAME47026EF7” on the restore target.

LUN Restore Issue. When restoring a LUN, the Avamar Administrator Restore 
to original location setting does not correctly restore the data as a LUN. The 
interim solution is to manually specify a NetApp Qtree root directory as a restore 
location for the LUN. Doing this will cause the NetApp filer to create the proper 
LUN container.
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EMC CELERRA INSTALLATION AND CONFIGURATION

This chapter describes how to install and configure the Avamar NDMP Accelerator 
for use with supported EMC Celerra IP storage systems.

Connect Components to Your Network
The following diagram shows a typical Avamar NDMP Accelerator deployment.

1. Connect your Avamar server, Avamar NDMP Accelerator and Celerra to 
your corporate LAN by using 100baseT or 1000baseT network connections.

2. Add each hostname to corporate DNS or modify /etc/hosts files on each 
network host such that:

(a) Avamar server and Avamar NDMP Accelerator can resolve each other’s 
hostnames. 

(b) Avamar NDMP Accelerator and Celerra can resolve each other’s 
hostnames.

NOTE:  It is not required that the Avamar server and Celerra
be able to directly resolve each other’s hostnames.

LAN/WANLAN
Print Server

Link/Rx LPT1 LPT2 COMPower/TX

STORAGE 
DEVICE-1

AVAMAR NDMP 
ACCELERATOR

AVAMAR SERVER

STORAGE 
DEVICE-2
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 Verify Networking
EMC CELERRA INSTALLATION AND CONFIGURATION
Verify Networking
In order for all aspects of the Avamar NDMP Accelerator to function properly, the 
Avamar server and Avamar NDMP Accelerator must be resolvable by corporate 
DNS from each other. Similarly, the Avamar NDMP Accelerator and Celerra must 
also be resolvable by corporate DNS from each other.

1. Deploy your Avamar server, Avamar NDMP Accelerator and Celerra on your 
network.

2. Ensure that your Avamar server, Avamar NDMP Accelerator and Celerra are 
turned on and operating properly.

User=admin 3. Open a command shell and log into your Avamar server as user admin.

4. Type:

ping ACCEL

Where ACCEL is the actual Avamar NDMP Accelerator IP address or 
hostname as defined in corporate DNS.

This command should demonstrate that the Avamar NDMP Accelerator is 
responding to the ping command.

User=admin 5. Open a command shell and log into the Avamar NDMP Accelerator as user 
admin.

6. Type:

ping AVAMARSERVER

ping CELERRA

Where AVAMARSERVER and CELERRA are the actual IP addresses or 
hostnames as defined in corporate DNS, of your Avamar server and 
Celerra, respectively.

These commands should demonstrate that both the Avamar server and 
Celerra are both responding to the ping commands.

7. Log into Celerra Manager.

8. Expand the NetWork menu (along left side), then click the Ping tab.

9. Ping the Avamar NDMP Accelerator 

This command should demonstrate that the Avamar NDMP Accelerator is 
responding to the ping command.

IMPORTANT:  Any failure to correctly resolve any hostname
from any of the network hosts involved in this integration
(Avamar server, Avamar NDMP Accelerator or Celerra) must
be identified and corrected before proceeding any further
with this installation procedure.
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Installation Procedure
In order to successfully install and configure an Avamar NDMP Accelerator, you 
must perform all of the following tasks in the following order:

• Create ndmp User Account on Celerra (page 16)
• Obtain and Copy Avamar NDMP Accelerator Install Packages (page 17)
• Install Avamar Linux Client (page 18)
• Install Avamar NDMP Accelerator (page 18)
• Configure and Register the Accelerator (page 19)

Create ndmp User Account on Celerra

1. Log into Celerra Manager.

2. Create a user account named ndmp (case-sensitive, all lower case).

3. Create a password for the ndmp user account.

4. Note this password for future use. 

You will need to type this password during the Configure and Register the 
Accelerator (page 19) installation task.

5. Ensure that the ndmp user account has sufficient privileges to run NDMP 
jobs and access all data on the Celerra.

Modify NDMP snapTimeout Parameters If Necessary

To avoid problems with running multiple NDMP backups simultaneously, increase 
the value for the NDMP snapTimeout parameter. The default value for the NDMP 
snapTimeout parameter is 5 minutes. Increase the value to at least 30 minutes. 
The following command can be used from the CLI on the Control Station:

server_param server_2 -f NDMP -m snapTimeout -v 30

Additional information for changing Celerra server parameters is available in the 
EMC Celerra Network Server Parameter Guide.
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Obtain and Copy Avamar NDMP Accelerator Install Packages

The easiest way to obtain Avamar Linux Client and Avamar NDMP Accelerator 
install packages is to copy them from an operational Avamar server on your 
network to your accelerator. The remainder of this task explains how to do this. 

TIP:  You can also extract the Avamar Linux Client and
Avamar NDMP Accelerator packages from a customer tarball.
For information about obtaining and extracting individual
installation packages from a customer tarball, contact EMC
Technical Support.

User=root 1. Open a command shell and log into the Avamar server as root.

2. Use a secure copy program to copy the Avamar Linux Client and Avamar 
NDMP Accelerator packages from the Avamar server to a temporary 
directory on the accelerator by typing the following commands:

cd /usr/local/avamar/src/RHEL4_64

scp AVAMARLINUX.rpm root@ACCELERATOR:/tmp

scp AVAMARNDMP.rpm root@ACCELERATOR:/tmp

Where AVAMARLINUX.rpm, and AVAMARNDMP.rpm are the actual 
filenames of the Avamar Linux Client and Avamar NDMP Accelerator 
packages and ACCELERATOR is the accelerator hostname or IP address. 

NOTE:  /tmp is used as an example temporary install direc-
tory in the remainder of this chapter. Your actual temporary
install directory may be different.

3. Note the actual filenames of the Avamar Linux Client and Avamar NDMP 
Accelerator packages. 

NOTE:  AVAMARLINUX.rpm and AVAMARNDMP.rpm are used
as example filenames for the Avamar Linux Client and
Avamar NDMP Accelerator install packages, respectively.
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Install Avamar Linux Client

User=root 1. Open a command shell and log into the accelerator as root.

2. Change directory to the temporary install directory you created in the 
previous task (page 17). 

cd /tmp

3. Type:

rpm -ivh AVAMARLINUX.rpm

Where AVAMARLINUX.rpm is the actual filename of the Avamar Linux 
Client install package you previously downloaded.

The following appears in the command shell:

Preparing... ########################################### [100%]
1:AvamarClient

########################################### [100%]
Installation complete
You may run /usr/local/avamar/bin/avregister to register and activate this 
client with the Administrator server.
avagent Info <5241>: Logging to /usr/local/avamar/var/avagent.log
avagent Info <5417>: daemonized as process id 23920
avagent.d Info: Client Agent started.

Install Avamar NDMP Accelerator

User=root 1. Ensure that you are still logged into the accelerator as root.

2. Change directory to the temporary install directory you created in the 
previous task (page 17). 

cd /tmp

3. Type:

rpm -ivh AVAMARNDMP.rpm

Where AVAMARNDMP.rpm is the actual filename of the Avamar NDMP 
Accelerator install package you previously downloaded.
The following appears in the command shell:
Preparing... ########################################### [100%]

1:AvamarNDMP
########################################### [100%]
ndmjob Info: Server started.
avagent Info: Stopping Avamar Client Agent (avagent)...
avagent Info: Client Agent stopped.
avagent Info <5241>: Logging to /usr/local/avamar/var/avagent.log
avagent Info <5417>: daemonized as process id 23956
avagent Info: Client Agent started.
Installation complete
You may run /usr/local/avamar/bin/avsetupndmp to register and activate this 
NDMP Accelerator Node with the Administrator server.
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Configure and Register the Accelerator

Avamar NDMP Accelerator configuration is performed by the avsetupndmp script; 
registering the accelerator with the Avamar server is performed by the 
avregister script.

User=root 1. Ensure that you are still logged into the accelerator as root.

Configure
Accelerator

2. Type:

avsetupndmp

The following appears in the command shell:
Configure systems for backup and restore.

avsetupndmp will stop all running agents, do you wish to continue Y/N? [Y]:

IMPORTANT:  Stopping all running agents will permanently
cancel any backups in progress.

3. Press ENTER to accept the default action to stop all running agents.

The following appears in the command shell:
avagent Info: Stopping Avamar Client Agent (avagent)...
avagent Info: Client Agent stopped. [ OK ]
Successfully copied init script.
Configure Avamar Server parameters.
Reading /usr/local/avamar/etc/usersettings.cfg...

Network address or DNS name of the Avamar Server [avamar-1.example.com]: 

4. Type the Avamar server DNS name or IP address and press ENTER.

avamar-1.example.com is used as an example Avamar server name for the 
remainder of this procedure.
The following appears in the command shell:
Root password of Avamar Server [*****]:

5. Type the Avamar server software root password and press ENTER.

NOTE:  This prompt is not asking for the operating system
root password; it is asking for the Avamar server software
root password.

The following appears in your command shell:

Enable support for multiple simultaneous backups? (IMPORTANT: Requires 8 or 
more GB of RAM) [N]:

IMPORTANT:  Enabling support for multiple simultaneous
backups without satisfying the minimum hardware and oper-
ating system requirements specified in General Capabilities
and Limitations (page 9) will adversely affect backup perfor-
mance.
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6. Do one of the following:

The following appears in the command shell:

Writing /usr/local/avamar/etc/usersettings.cfg...
Successfully wrote '/usr/local/avamar/etc/usersettings.cfg'
Configure individual system parameters.

The following systems are configured:

Choose an action:
 1. Add a new system
 2. Edit an existing system
 3. Remove a system from the list
 4. Exit setup
Enter action: [4]:

7. Type 1 and press ENTER.

The following appears in the command shell:
Setting up a new system account

What kind of system do you want to setup?
  1. EMC Celerra
  2. NetApp Filer
Enter choice:

8. Type 1 and press ENTER. 

The following appears in your command shell:
Starting setup for EMC Celerra
Network address or DNS name of the EMC Celerra [filer.company.com]:

9. Type the Celerra DNS name or IP address and press ENTER.

MyCelerra.example.com is used as an example Celerra name for the 
remainder of this procedure.
The following appears in your command shell:
The ndmp user password on "MyCelerra.example.com":

IMPORTANT:  This password cannot contain single-quotes.

10. Type the Celerra ndmp user account password you created in Create ndmp 
User Account on Celerra (page 16) and press ENTER. 

The following appears in the command shell:
Repeat password:

IF DO THIS

You want to enable multiple 
simultaneous backups.

Type y and press ENTER.

You do not want to enable 
multiple simultaneous backups.

Press ENTER to accept the default 
action (do not enable multiple 
simultaneous backups).
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11.Re-type the same password you entered in step 10 and press ENTER. 

The following appears in the command shell:
Password encoding scheme ("md5" or "text") to use for "MyCelerra.example.com" 
[md5]:

You must specify the correct password encoding scheme currently in use 
on your Celerra. 

IMPORTANT:  The only valid entries are md5 or text; any
other entries or specifying the incorrect encoding scheme
will cause an error.

12. Type the correct password encoding scheme (either md5 or text) and press 
ENTER. 

The following appears in the command shell:
Checking username and password... verified Avamar account name for 
"MyCelerra.example.com" [MyCelerra.example.com]: 

This prompt is asking for a descriptive name for this Celerra client instance 
that will appear various places in Avamar Administrator. Any user-defined 
name is acceptable. The default Avamar account name is the Celerra DNS 
name or IP address you previously entered in step 9. 

IMPORTANT:  This name must be unique. Be especially
careful when adding a second client instance of the same
Celerra system that you differentiate it from any existing
Avamar account name.

MyCelerra.example.com is used as an example Avamar account name for 
the remainder of this procedure.

13.Do one of the following:

The following appears in the command shell:
Routable address or DNS name of this accelerator from "MyFiler.example.com" 
[ndmpa-1.example.com]:

14.Type this accelerator DNS name or IP address and press ENTER.

ndmpa-1.example.com is used as an example accelerator name for the 
remainder of this procedure.
The following appears in the command shell:
Writing /usr/local/avamar/var/MyCelerra-ndmpa3/.avagent...
Writing /usr/local/avamar/var/MyCelerra-ndmpa3/ndmp.cfg...
 
Trying to get list of volumes from MyCelerra.example.com...

IF DO THIS

You want to specify an Avamar 
account name other than the default.

Type your account name and 
press ENTER.

You want to use the default Avamar 
account name.

Press ENTER to accept the 
default Avamar account name.
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Trying to get list of volumes from MyCelerra.example.com...
<dir name="/CIFS_share1" />
<dir name="/NFS_share1" />
<dir name="/.etc_common" />
<dir name="/" />
Finished setup for MyCelerra.example.com:/usr/local/avamar/var/MyCelerra-
ndmpa3.
 
The following filers are configured:
 MyCelerra-ndmpa3 /usr/local/avamar/var/MyCelerra-ndmpa3
 
Choose an action:
 1. Add a new filer
 2. Edit an existing filer
 3. Remove a filer from the list
 4. Exit setup
Enter action: [4]:

15.Do one of the following:

16.Wait for avsetupndmp to complete.

The following appears in the command shell:
Attempting to restart avagent service.

avagent Info: Client 'MyCelerra.example.com' in directory '/usr/local/avamar/
var/MyCelerra.example.com'
avagent Info <5241>: Logging to /usr/local/avamar/var/MyCelerra.example.com/
avagent.log
avagent Info <5417>: daemonized as process id 6669
avagent Info: Client Agent MyCelerra.example.com started. [ OK ]

IMPORTANT: Be sure to run avregister if you have added new accounts.

Register and
Activate

Accelerator With
the Avamar Server

17.Type the following:

avregister

NOTE:  If you added more than one Celerra or client
instance during your avsetupndmp session, avregister will
automatically attempt to register all client instances it
detects on the accelerator. 

The following appears in the command shell:
=== Client Registration and Activation
This script will register and activate the client with the Administrator 
server.
Enter the Administrator server address (DNS text name or numeric IP address, 
DNS name preferred):

IF DO THIS

You want to add another Celerra or 
an additional Avamar client instance 
of an existing Celerra now.

Select menu option 1 (by typing 
1 and pressing ENTER) and 
repeat steps 7 thru 15.

You do not want to add another 
Celerra or an additional Avamar 
client instance of an existing Celerra 
now.

Press ENTER to accept the 
default action (exit setup).
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18.Type the actual network hostname (as defined in DNS) of your Avamar 
Administrator server and press ENTER.

The following appears in the command shell:
Enter the Avamar server domain [clients]:

The default domain is “clients.” However, your Avamar system 
administrator may have defined other domains and sub-domains. Consult 
your Avamar system administrator for the specific domain you should use 
when registering this client.

IMPORTANT:  If typing a sub-domain (for example, 
clients/linux), do not include a slash (/) as the first charac-
ter. Including a slash as the first character will cause an error
and prevent you from registering this client.

19. Press ENTER to accept the default domain (clients).

The following appears in the command shell:

avagent.d Info: Server stopped. [ OK ]
avagent Info <5241>: Logging to /usr/local/avamar/var/avagent.log
avagent.d Info: Client activated successfully. [ OK ]
avagent Info <5241>: Logging to /usr/local/avamar/var/avagent.log
avagent Info <5417>: daemonized as process id 3385
avagent.d Info: Server started. [ OK ]
Registration Complete.
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NETAPP INSTALLATION AND CONFIGURATION

This chapter describes how to install and configure the Avamar NDMP Accelerator 
for use with supported NetApp filers.

Connect Components to Your Network
The following diagram shows a typical Avamar NDMP Accelerator deployment.

1. Connect your Avamar server, Avamar NDMP Accelerator and filer to your 
corporate LAN by using 100baseT or 1000baseT network connections.

2. Add each hostname to corporate DNS or modify /etc/hosts files on each 
network host such that:

(a) Avamar server and Avamar NDMP Accelerator can resolve each other’s 
hostnames. 

(b) Avamar NDMP Accelerator and filer can resolve each other’s 
hostnames.

NOTE:  It is not required that the Avamar server and filer be
able to directly resolve each other’s hostnames.

LAN/WANLAN
Print Server

Link/Rx LPT1 LPT2 COMPower/TX

STORAGE 
DEVICE-1

AVAMAR NDMP 
ACCELERATOR

AVAMAR SERVER

STORAGE 
DEVICE-2
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Verify Networking
In order for all aspects of the Avamar NDMP Accelerator to function properly, the 
Avamar server and Avamar NDMP Accelerator must be resolvable by corporate 
DNS from each other. Similarly, the Avamar NDMP Accelerator and filer must also 
be resolvable by corporate DNS from each other.

1. Deploy your Avamar server, Avamar NDMP Accelerator and filer on your 
network.

2. Ensure that your Avamar server, Avamar NDMP Accelerator and filer are 
turned on and operating properly.

User=admin 3. Open a command shell and log into your Avamar server as user admin.

4. Type:

ping ACCEL

Where ACCEL is the actual Avamar NDMP Accelerator IP address or 
hostname as defined in corporate DNS.

This command should demonstrate that the Avamar NDMP Accelerator is 
responding to the ping command.

User=admin 5. Open a command shell and log into the Avamar NDMP Accelerator as user 
admin.

6. Type:

ping AVAMARSERVER

ping FILER

Where AVAMARSERVER and FILER are the actual IP addresses or 
hostnames as defined in corporate DNS, of your Avamar server and filer, 
respectively.

These commands should demonstrate that both the Avamar server and 
filer are both responding to the ping commands.

7. Open a command shell and log into the filer.

8. Type:

ping ACCEL

Where ACCEL is the actual Avamar NDMP Accelerator IP address or 
hostname as defined in corporate DNS.

This command should demonstrate that the Avamar NDMP Accelerator is 
responding to the ping command.

9. Also ensure that the filer allows NDMP connections from the Avamar NDMP 
Accelerator by typing:

options ndmpd.access
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10.Do one of the following:

IMPORTANT:  Any failure to correctly resolve any hostname
from any of the network hosts involved in this integration
(Avamar server, Avamar NDMP Accelerator or filer) must be
identified and corrected before proceeding any further with
this installation procedure.

IF DO THIS

The previous command 
returned all or legacy.

No further action is necessary.

The previous command did 
not return all or legacy.

Grant access to the Avamar NDMP 
Accelerator by typing either 
options ndmpd.access host=HOSTNAME 
- or -
options ndmpd.access host=IP-ADDR

Where HOSTNAME and IP-ADDR are the 
Avamar NDMP Accelerator hostname or 
IP address, respectively.
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Installation Procedure
In order to successfully install and configure an Avamar NDMP Accelerator, you 
must perform all of the following tasks in the following order:

• Obtain and Copy Avamar NDMP Accelerator Install Packages (page 27)
• Install Avamar Linux Client (page 28)
• Install Avamar NDMP Accelerator (page 28)
• Configure and Register the Accelerator (page 29)
• Enable NDMP Services on Filer (page 34)

Obtain and Copy Avamar NDMP Accelerator Install Packages

The easiest way to obtain Avamar Linux Client and Avamar NDMP Accelerator 
install packages is to copy them from an operational Avamar server on your 
network to your accelerator. The remainder of this task explains how to do this. 

TIP:  You can also extract the Avamar Linux Client and
Avamar NDMP Accelerator packages from a customer tarball.
For information about obtaining and extracting individual
installation packages from a customer tarball, contact EMC
Technical Support.

User=root 1. Open a command shell and log into the Avamar server as root.

2. Use a secure copy program to copy the Avamar Linux Client and Avamar 
NDMP Accelerator packages from the Avamar server to a temporary 
directory on the accelerator by typing:

cd /usr/local/avamar/src/RHEL4_64

scp AVAMARLINUX.rpm root@ACCELERATOR:/tmp

scp AVAMARNDMP.rpm root@ACCELERATOR:/tmp

Where AVAMARLINUX.rpm, and AVAMARNDMP.rpm are the actual 
filenames of the Avamar Linux Client and Avamar NDMP Accelerator 
packages and ACCELERATOR is the accelerator hostname or IP address. 

NOTE:  /tmp is used as an example temporary install direc-
tory in the remainder of this chapter. Your actual temporary
install directory may be different.

3. Note the actual filenames of the Avamar Linux Client and Avamar NDMP 
Accelerator packages. 

NOTE:  AVAMARLINUX.rpm and AVAMARNDMP.rpm are used
as example filenames for the Avamar Linux Client and
Avamar NDMP Accelerator install packages, respectively.
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Install Avamar Linux Client

User=root 1. Open a command shell and log into the accelerator as root.

2. Change directory to the temporary install directory you created in the 
previous task (page 27). 

cd /tmp

3. Type:

rpm -ivh AVAMARLINUX.rpm

Where AVAMARLINUX.rpm is the actual filename of the Avamar Linux 
Client install package you previously downloaded.

The following appears in the command shell:

Preparing... ########################################### [100%]
1:AvamarClient

########################################### [100%]
Installation complete
You may run /usr/local/avamar/bin/avregister to register and activate this 
client with the Administrator server.
avagent Info <5241>: Logging to /usr/local/avamar/var/avagent.log
avagent Info <5417>: daemonized as process id 23920
avagent.d Info: Client Agent started.

Install Avamar NDMP Accelerator

User=root 1. Ensure that you are still logged into the accelerator as root.

2. Change directory to the temporary install directory you created in the 
previous task (page 27). 

cd /tmp

3. Type:

rpm -ivh AVAMARNDMP.rpm

Where AVAMARNDMP.rpm is the actual filename of the Avamar NDMP 
Accelerator install package you previously downloaded.
The following appears in the command shell:
Preparing... ########################################### [100%]

1:AvamarNDMP
########################################### [100%]
ndmjob Info: Server started.
avagent Info: Stopping Avamar Client Agent (avagent)...
avagent Info: Client Agent stopped.
avagent Info <5241>: Logging to /usr/local/avamar/var/avagent.log
avagent Info <5417>: daemonized as process id 23956
avagent Info: Client Agent started.
Installation complete
You may run /usr/local/avamar/bin/avsetupndmp to register and activate this 
NDMP Accelerator Node with the Administrator server.
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Configure and Register the Accelerator

Avamar NDMP Accelerator configuration is performed by the avsetupndmp script; 
registering the accelerator with the Avamar server is performed by the 
avregister script.

User=root 1. Ensure that you are still logged into the accelerator as root.

Configure
Accelerator

2. Type:

avsetupndmp

The following appears in the command shell:
Configure systems for backup and restore.

avsetupndmp will stop all running agents, do you wish to continue Y/N? [Y]:

IMPORTANT:  Stopping all running agents will permanently
cancel any backups in progress.

3. Press ENTER to accept the default action to stop all running agents.

The following appears in the command shell:
avagent Info: Stopping Avamar Client Agent (avagent)...
avagent Info: Client Agent stopped. [ OK ]
Successfully copied init script.
Configure Avamar Server parameters.
Reading /usr/local/avamar/etc/usersettings.cfg...

Network address or DNS name of the Avamar Server [avamar-1.example.com]: 

4. Type the Avamar server DNS name or IP address and press ENTER.

avamar-1.example.com is used as an example Avamar server name for the 
remainder of this procedure.

The following appears in the command shell:
Root password of Avamar Server [*****]:

5. Type the Avamar server software root password and press ENTER.

NOTE:  This prompt is not asking for the operating system
root password; it is asking for the Avamar server software
root password.

The following appears in your command shell:
Enable support for multiple simultaneous backups? (IMPORTANT: Requires 8 or 
more GB of RAM) [N]:

IMPORTANT:  Enabling support for multiple simultaneous
backups without satisfying the minimum hardware and oper-
ating system requirements specified in General Capabilities
and Limitations (page 9) will adversely affect backup perfor-
mance.
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6. Do one of the following:

The following appears in the command shell:

Writing /usr/local/avamar/etc/usersettings.cfg...
Successfully wrote '/usr/local/avamar/etc/usersettings.cfg'
Configure individual system parameters.

The following systems are configured:

Choose an action:
 1. Add a new system
 2. Edit an existing system
 3. Remove a system from the list
 4. Exit setup
Enter action: [4]:

7. Type 1 and press ENTER.

The following appears in the command shell:
Setting up a new system account
 
What kind of system do you want to setup?
  1. EMC Celerra
  2. NetApp Filer
Enter choice: 

8. Type 2 and press ENTER. 

The following appears in your command shell:
Starting setup for NetApp Filer
Network address or DNS name of the NetApp Filer [filer.company.com]:

9. Type the NDMP filer DNS name or IP address and press ENTER.

MyFiler.example.com is used as an example NDMP filer name for the 
remainder of this procedure.
The following appears in your command shell:
NDMP user on "MyFiler.example.com" [root]:

This prompt is asking for a login account on the filer that has sufficient 
privileges to run NDMP jobs and access all data on the filer. The root user 
account always has sufficient privileges but you may specify another user 
account at your discretion.

IMPORTANT:  If the user account you specify in the follow-
ing step does not have sufficient privileges to run NDMP jobs
and access all data on the filer, backups might not be initi-
ated or might be incomplete.

IF DO THIS

You want to enable multiple 
simultaneous backups.

Type y and press ENTER.

You do not want to enable 
multiple simultaneous backups.

Press ENTER to accept the default 
action (do not enable multiple 
simultaneous backups).
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10.Do one of the following:

11.Do one of the following:

The following appears in the command shell:

Password for "root" on "MyFiler.example.com":

12.Type the filer user account password and press ENTER. 

The following appears in the command shell:
Repeat password:

13.Re-type the same password you entered in step 12 and press ENTER. 

The following appears in the command shell:
Password encoding scheme ("md5" or "text") to use for "MyFiler.example.com" 
[md5]:

You must specify the correct password encoding scheme currently in use 
on your NDMP filer. 

IMPORTANT:  The only valid entries are md5 or text; any
other entries or specifying the incorrect encoding scheme
will cause an error.

TIP:  To determine which password encoding scheme is cur-
rently in use on your NDMP filer, open a command shell, log
into the filer and run the options ndmpd.authtype com-
mand. This command returns either plaintext or chal-
lenge. 
 - If plaintext is returned, then text is the correct entry. 
 - If challenge is returned, then md5 is the correct entry. 

EMC recommends using challenge/md5 encrypted passwords
whenever possible.

IF DO THIS

You intend to use the default 
user account (root).

Skip this step and go directly to step 11.

You intend to specify a filer 
account other than root.

Verify that the user account you intend 
to use has administrator privileges, or, at 
a minimum, has cli-ndmpd* and 
cli-ndmpcopy* CLI rights capabilities.

IF DO THIS

You want to use the default 
user account (root).

Press ENTER to accept the default filer 
account name (root).

You want to specify a filer 
account other than root.

Type your account name and press 
ENTER.
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14.Type the correct password encoding scheme (either md5 or text) and press 
ENTER. 

The following appears in the command shell:
Checking username and password... verified Avamar account name for 
"MyFiler.example.com" [MyFiler.example.com]: 

This prompt is asking for a descriptive name for this NDMP filer client 
instance that will appear various places in Avamar Administrator. Any user-
defined name is acceptable. The default Avamar account name is the filer 
DNS name or IP address you previously entered in step 9. 

IMPORTANT:  This name must be unique. Be especially
careful when adding a second client instance of the same
filer that you differentiate it from any existing Avamar
account name.

MyFiler.example.com is used as an example Avamar account name for the 
remainder of this procedure.

15.Do one of the following:

The following appears in the command shell:
Routable address or DNS name of this accelerator from "MyFiler.example.com" 
[ndmpa-1.example.com]:

16.Type this accelerator DNS name or IP address and press ENTER.

ndmpa-1.example.com is used as an example accelerator name for the 
remainder of this procedure.
The following appears in the command shell:
Writing /usr/local/avamar/var/MyFiler.example.com/.avagent...
Writing /usr/local/avamar/var/MyFiler.example.com/ndmp.cfg...

Trying to get list of volumes from MyFiler.example.com...

<dir name="/vol/local1" />
<dir name="/vol/local2" />
Finished setup for MyFiler.example.com:/usr/local/avamar/var/
MyFiler.example.com.

The following filers are configured:
 MyFiler.example.com /usr/local/avamar/var/MyFiler.example.com

Choose an action:
 1. Add a new filer
 2. Edit an existing filer
 3. Remove a filer from the list
 4. Exit setup
Enter action: [4]:

IF DO THIS

You want to specify an Avamar 
account name other than the default.

Type your account name and 
press ENTER.

You want to use the default Avamar 
account name.

Press ENTER to accept the 
default Avamar account name.
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17.Do one of the following:

18.Wait for avsetupndmp to complete.

The following appears in the command shell:
Attempting to restart avagent service.

avagent Info: Client 'MyFiler.example.com' in directory '/usr/local/avamar/var/
MyFiler.example.com'
avagent Info <5241>: Logging to /usr/local/avamar/var/MyFiler.example.com/
avagent.log
avagent Info <5417>: daemonized as process id 6669
avagent Info: Client Agent MyFiler.example.com started. [ OK ]

IMPORTANT: Be sure to run avregister if you have added new accounts.

Register and
Activate

Accelerator With
the Avamar Server

19.Type the following:

avregister

NOTE:  If you added more than one filer or client instance
during your avsetupndmp session, avregister will automat-
ically attempt to register all client instances it detects on the
accelerator. 

The following appears in the command shell:
=== Client Registration and Activation
This script will register and activate the client with the Administrator 
server.
Enter the Administrator server address (DNS text name or numeric IP address, 
DNS name preferred):

20.Type the actual network hostname (as defined in DNS) of your Avamar 
Administrator server and press ENTER.

The following appears in the command shell:
Enter the Avamar server domain [clients]:

The default domain is “clients.” However, your Avamar system 
administrator may have defined other domains and sub-domains. Consult 
your Avamar system administrator for the specific domain you should use 
when registering this client.

IMPORTANT:  If typing a sub-domain (for example, 
clients/linux), do not include a slash (/) as the first charac-
ter. Including a slash as the first character will cause an error
and prevent you from registering this client.

IF DO THIS

You want to add another filer or an 
additional Avamar client instance of 
an existing filer now.

Select menu option 1 (by typing 
1 and pressing ENTER) and 
repeat steps 7 thru 17.

You do not want to add another filer 
or an additional Avamar client 
instance of an existing filer now.

Press ENTER to accept the 
default action (exit setup).
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21. Press ENTER to accept the default domain (clients).

The following appears in the command shell:

avagent.d Info: Server stopped. [ OK ]
avagent Info <5241>: Logging to /usr/local/avamar/var/avagent.log
avagent.d Info: Client activated successfully. [ OK ]
avagent Info <5241>: Logging to /usr/local/avamar/var/avagent.log
avagent Info <5417>: daemonized as process id 3385
avagent.d Info: Server started. [ OK ]
Registration Complete.

Enable NDMP Services on Filer

In order to back up your NetApp filer to your Avamar server, you must enable the 
Network Data Management Protocol (NDMP) services on your filer.

1. Point your web browser at your NetApp filer by typing the following URL:

http://MyFiler.example.com/na_admin

Where MyFiler.example.com is your actual NetApp filer network hostname 
(as defined in DNS) or IP address.

Depending on your browser security settings, a security alert dialog box 
might appear. 

2. If a security alert dialog box appears, click Yes or OK to allow redirection 
to your NetApp filer administration page. 

You may be prompted for login credentials at this point.

3. If a login dialog box appears, type a valid NetApp administrative user name 
and password, then click Yes or OK to log into the NetApp filer.

The NetApp administration page appears.

4. Click FilerView.

The FilerView page appears.
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5. Click NDMP.

The Enable/Disable NDMP Services page appears.

If NDMP is already enabled, your Enable/Disable NDMP Services page will 
look like this:

The status NDMP is enabled appears and the alternate action button label 
is Disable NDMP.

6. If NDMP is disabled, click Enable NDMP.

Your Enable/Disable NDMP Services page will now look like the one 
previously shown.

TIP:  You can also enable NDMP by opening a command
shell, logging into the filer, and running the 
options ndmpd.enable on command.
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POST-INSTALLATION AND CONFIGURATION

This chapter discusses how to change Avamar NDMP Accelerator configuration 
settings, as well as how to uninstall or upgrade Avamar NDMP Accelerator 
software.

Changing Accelerator Configuration Settings
The avsetupndmp program can be re-run as often as necessary to re-configure 
accelerator settings.

Previously configured storage devices or storage device client instances can be 
edited or removed by choosing the respective option in the avsetupndmp menu.

If you want to use the accelerator with a different Avamar server, you must re-run 
avregister.

IMPORTANT:  You must always re-run avregister after
adding a new storage device or new client instance of an
existing storage device.
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Uninstalling Avamar NDMP Accelerator Software
User=root 1. Open a command shell and log into the accelerator as root.

2. Query the RPM database for the currently installed clients by typing:

rpm -qa | grep Avamar

The following appears in the command shell:

AvamarClient-VERSION
AvamarNDMP-VERSION

Where VERSION is the actual version of each piece of EMC software 
currently installed on your system.

3. Uninstall the AvamarNDMP software by typing:

rpm -e AvamarNDMP-VERSION

Where AvamarNDMP-VERSION is the actual software package name 
returned in step 2.
The following appears in the command shell:
ndmjob Info: Server stopped.
avagent Info: Stopping Avamar Client Agent (avagent)...
avagent Info: Client Agent stopped.
avagent Info <5241>: Logging to /usr/local/avamar/var/avagent.log
avagent Info <5417>: daemonized as process id 23997
avagent Info: Client Agent started.

4. Uninstall the AvamarClient software by typing:

rpm -e AvamarClient-VERSION

Where AvamarClient-VERSION is the actual software package name 
returned in step 2.

The following appears in the command shell:

avagent.d Info: Stopping Avamar Client Agent (avagent)...
avagent.d Info: Client Agent stopped.

Upgrading Avamar NDMP Accelerator Software
In order to upgrade your Avamar NDMP Accelerator and Linux client software, you 
must completely uninstall the old software and install the new software. Use of the 
Linux software upgrade command (rpm -Uh) is not supported.
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Configuring NTP Time Services
User=root 1. Open a command shell and log into the accelerator as root.

2. Copy the /etc/ntp.conf and /etc/ntp/step-tickers files from the utility node 
by typing:

ssh -x root@ACCELERATOR-NODE

cp -p /etc/ntp.conf{,.orig}

scp root@UTILITY-NODE:/etc/ntp.conf /etc/

cp -p /etc/ntp/step-tickers{,.orig}

scp root@UTILITY-NODE:/etc/ntp/step-tickers /etc/ntp/

Where ACCELERATOR-NODE and UTILITY-NODE are the network names or 
IP addresses of the accelerator and utility nodes, respectively.

3. Restart the ntpd service by typing: 

service ntpd restart

4. Verify the ntpd service started correctly by typing:

service ntpd status

5. Wait 7 to 10 minutes for the system to fully settle.

6. Verify that the ntpd service is synchronizing time by typing:

/usr/sbin/ntpq -pn 

7. Verify that the reach column values eventually become non-zero and that 
an asterisk appears in the left column of one of the time servers.

Ideally all reach values are 377, which is an octal value meaning that the 
last 8 time server contacts were all successful, with no misses.

8. If there are zero reach values, then troubleshoot as follows:

(a) Verify that the list of time servers is correct in /etc/ntp.conf. Check this 
on server nodes 0.s and 0.0 as well.

The restrict statements in /etc/ntp.conf on nodes 0.s and 0.0 should 
permit other nodes, such as the accelerator node, to obtain time. 

(b) However, if this is not the case, and the reach values for nodes 0.s and 
0.0 remain zero on the accelerator node, then add the following line in 
/etc/ntp.conf on nodes 0.s and 0.0 for each NDMP Accelerator node IP 
address:

restrict ACCELERATOR-NODE-ADDRESS nomodify

Where ACCELERATOR-NODE-ADDRESS is the IP address of the 
accelerator node.

In spite of the meaning of the word restrict, the point here is to un-
restrict access from the specified accelerator node.

(c) After making changes to /etc/ntp.conf on nodes 0.s and 0.0, restart 
ntpd on those nodes by typing:

service ntpd restart
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(d) Verify that there are no errors, and that the ntpd service is 
synchronizing time by typing:

/usr/sbin/ntpq -pn 

(e) If problems remain, it is possible that the problems are systemic or 
network-related and require additional troubleshooting. Contact EMC 
Technical Support for assistance.

9. Ensure that ntpd will start up at the next reboot by typing:

chkconfig ntpd on 

10. If you have not already done so, set the local time zone on the accelerator 
by typing:

/usr/sbin/timeconfig

IMPORTANT:  For best results, you should set accelerator
local time to that of the NDMP storage device so that both
client and accelerator log files correlate.

11.Select the correct local time zone from the time zone menu.

12.Verify that the output of the date command is as expected by typing:

date
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USING AVAMAR NDMP ACCELERATOR

This chapter describes how to use the Avamar NDMP Accelerator to perform full or 
incremental backups and recoveries (restores) of supported EMC Celerra IP 
storage systems and NetApp filers.

NOTE:  For the sake of clarity, this publication often uses the
term “storage device” to generically refer to any supported
EMC Celerra IP storage system or NetApp filer.

Performing an On-Demand Backup
1. Start Avamar Administrator.

2. Select Navigation > Backup and Restore or click the 
Backup & Restore launcher button.

The Backup and Restore window appears. 

3. Click the Select for Backup tab.
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4. In the Clients tree, select the storage device client instance you want to 
back up.

The filesystem appears as a volume tree immediately to the right of the 
Clients tree. Placing a check mark next to a volume selects it for backup. 

IMPORTANT:  Each individual backup operation can only
comprise one target volume. If you try to backup more than
one volume, an error will occur.

TIP:  Select Actions > Preview List... to view a summary
of all directories and files you have just selected for an on-
demand backup.

5. Select Actions > Backup Now… or click the toolbar icon shown 
immediately to the left.

The On Demand Backup Options dialog box appears.

6. Review your backup settings.

Clicking Cancel returns you to the Backup and Restore window where you 
can modify your backup selections.

Retention Policy Settings control how long this backup will be kept for 
potential restores. 
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7. Select the encryption method you want to use for client/server data 
transfer during this backup.

Choices are:

8. If you want to change your backup retention setting, select or type the 
following:

TIP:  If you want to include plug-in options with this backup,
click More Options..., then select or clear the desired
options and type values where applicable.

High Strongest available encryption setting for that specific client 
platform.

Medium Medium strength encryption.

None No encryption.

NOTE:  The exact encryption technology and bit strength used for any 
given client/server connection is dependent on a number of factors, 
including the client platform and Avamar server version. Refer to your 
Avamar Product Security Guide for additional information.

FIELD/OPTION DESCRIPTION

Retention from today If you want this backup to be deleted from the 
Avamar server after a specific number of days, 
weeks, months or years, select this option and 
type the number of days, weeks, months or 
years.

End date If you want this backup to be deleted from the 
Avamar server on a specific calendar date, select 
this option and browse to that date on the 
calendar.

No end date If you want to keep this backup for as long as 
this client remains active in the Avamar server, 
select this option.
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Forcing Full or
Incremental

Backups

By default, Avamar will automatically determine whether to take a full or 
incremental backup of this storage device. The first backup is always a full 
(level 0). Each subsequent backup is an incremental (level 1). Avamar will 
intelligently merge any previous backup data with the new level 1 
incremental, thereby always resulting in a full backup.

However, if you want to force a full (level 0) or incremental (level 1) 
backup, click More Options..., select the Show Advanced Options 
option and select the desired Filer Dump Mode (either Force a level 0 dump 
or Force an incremental (level 1) dump).

IMPORTANT:  Forcing a full (level 0) dump will re-send all
data in the requested volume from the storage device to the
accelerator. This is not recommended.

IMPORTANT:  For best results, always perform incremental
Celerra backups at the volume level. For Celerra, Avamar will
default to performing full backups of lower level directories
and subdirectories. However, it is possible to override this
default behavior and force an incremental backup of lower
level directories and subdirectories. This is not a good prac-
tice as it can cause unpredictable application behavior.

9. Click OK.

The On Demand Backup Options dialog box closes and the following status 
message appears: Backup initiated.

10.Click OK to close the status message dialog box.
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Select for Restore Overview
The Backup and Restore window Select for Restore tab provides two different 
ways to locate and select a backup stored on the server:

• By calendar date (page 44)
• By content (page 45)

Locating and Selecting a Backup by Calendar Date

In order to locate backups stored on the 
server by calendar date, perform the 
following:

1. Select a Client in the clients tree.

2. Click the By Date tab.

Clicking the By Date tab displays a 
browsable calendar for locating 
backups in the Avamar server.

Dates highlighted in yellow indicate 
that a backup was performed on that 
date.

Selecting a valid backup date on the calendar populates the backups list 
immediately to the right of the calendar.

Selecting a backup populates the contents list directly below the Backup 
History pane.

3. In the Backup History pane, browse to a valid backup date in the Calendar 
(highlighted in yellow).

4. Select the backup from which you want to restore the volume.
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Locating and Selecting a Backup by Content

In order to locate backups by content (that is, specific directories, folders or files 
within that backup), perform the following:

1. Select a Client in the clients tree.

2. Click the By File/Folder tab.

Clicking the By File/Folder tab displays a Backup History pane that can be 
used to retrieve all backups that contain a specified client directory, folder 
or file.

3. Type a slash (/) in the Enter path to retrieve history for field.

4. Click Retrieve.

The Version History table lists all versions and sizes for that directory, 
folder or file that have been backed up from this client. 

Selecting a row in the Version History table shows all backups for the 
selected client that contains the selected version of the directory, folder or 
file. 

5. Select the backup from which you want to restore the volume.
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Performing a Recovery (Restore)
1. Start Avamar Administrator.

2. Select Navigation > Backup and Restore or click the 
Backup & Restore launcher button.

The Backup and Restore window appears. 

3. Click the Select for Restore tab.

4. In the Clients tree, select the storage device client instance.

5. Locate and select a backup from which you want to restore directories or 
files.

TIP:  Refer to Locating and Selecting a Backup by Calendar
Date (page 44), Locating and Selecting a Backup by Content
(page 45) for additional information about locating backups
by calendar date or content, respectively.

6. Select the volume you want to restore.

IMPORTANT:  Each individual restore operation can only
comprise one target volume. If you try to restore more than
one volume, an error will occur.

TIP:  Select Actions > Preview List... to view a summary
of all directories and files you have just selected for a
restore.

7. Select Actions > Restore Now… or click the toolbar icon shown 
immediately to the left.

The Restore Options dialog box appears.
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8. Review your restore settings.

Clicking Cancel returns you to the Backup and Restore window where you 
can modify your restore selections.

9. If you want to change your restore settings, select or type the following:

TIP:  If you want to include plug-in options with this restore,
click More Options..., then select or clear the desired
options and type values where applicable.

10.Click OK.

The Restore Options dialog box closes and the following status message 
appears: Restore initiated.

11.Click OK to close the status message dialog box.

FIELD/
OPTION DESCRIPTION

Restore 
Destination 
Choices

Restore destination choices allows you to specify which 
storage device client instance and top-level (root) 
directory will receive the restored files.

Restore Everything to its original location is the 
default destination — all files are restored to original 
storage device client instance in the original top-level 
(root) directory.

Restore Everything to a different location allows you 
to specify another client or another directory on the same 
storage device client instance. 
IMPORTANT:  The original instance path is not 
preserved unless specified (that is, it functions like 
Microsoft Windows "Save As"). For example, if the 
original path is /fs/dir1 and you decide to restore to 
/fs/newdir, files are restored to /fs/newdir rather than 
fs/newdir/dir1. Any ACLs applied to the original 
instance path are maintained after the recovery.
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Scheduling Backups
In order to have your storage device backups performed on a regular schedule, 
you must:

• Create a new group expressly for storage device backups
• Add the storage device client instance to this new group
• Assign a dataset to this new group
• Assign a schedule to this new group
• Assign a retention policy to this new group
• Enable scheduling for this new group

IMPORTANT:  Any single Avamar dataset can only point to
a maximum of one storage device volume and only one
dataset can be assigned to any particular group. This effec-
tively means that a separate group must be created and a
separate unique dataset created and assigned for each stor-
age device volume you want to backup.

A thorough discussion of groups, group policy, datasets, schedules and retention 
policies is beyond the scope of this publication. Refer to your Avamar System 
Administration Guide for additional information.

Setting Up Scheduled Backups

1. Start Avamar Administrator.

2. Select Navigation > Policy or click the Policy launcher button.

The Policy window appears.
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3. Select Actions > New Group… or click the toolbar icon shown 
immediately to the left.

The New Group wizard appears.

4. Select or type the following:

FIELD/OPTION DESCRIPTION

Name Type a name for this new group.
IMPORTANT:  Do not use any of the following 
characters in your group name: asterisk (*), forward 
slash (/), backward slash (\), colon (:), semicolon (;), 
question mark (?), greater-than sign (>), less-than 
sign (<) or vertical bar (|).

Disabled This option is selected by default. Clear this option if you 
want to immediately use this group to take regularly 
scheduled client backups.

Encryption 
Method

This is the group encryption method that will be used by 
all members of this group for client/server network 
communications unless it is overridden at the client 
level. Choices are:

High Strongest available encryption setting for 
that specific client platform.

Medium Medium strength encryption.

None No encryption.

NOTE:  The exact encryption technology and bit 
strength used for any given client-server connection is 
dependent on a number of factors, including the client 
platform and Avamar server version. Refer to your 
Avamar Product Security Guide for additional 
information.
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The remaining wizard screens are used to select a dataset, schedule and 
retention policy, as well as build a client list for this group.

You can click Finish at any time. Doing so will cause the new group to be 
created using system default settings and an empty client list. You can 
change those settings by editing the group properties.

5. Click Next.

The next New Group wizard screen appears.

This screen is used to select a dataset for use with this group.

6. Select a dataset from the Select an Existing Dataset drop-down list.

NOTE:  Datasets are not modifiable from this screen.
Detailed dataset properties are shown so that you can
review them prior to making your selection. Refer to your
Avamar System Administration Guide for additional informa-
tion about editing dataset properties.

Override 
Schedule

Select this option if you want to override the assigned 
schedule for this group.
You can also skip the next scheduled backup entirely 
(Skip Next Backup) or perform the next scheduled 
backup one time only (Run Next Backup Once).

Domain Location in the Avamar where this group should reside.

FIELD/OPTION DESCRIPTION
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7. Click Next.

The next New Group wizard screen appears.

This screen is used to select a schedule for use with this group.

8. Select a schedule from the Select an Existing Schedule drop-down list.

NOTE:  Schedules are not modifiable from this screen.
Detailed schedule properties are shown so that you can
review them prior to making your selection. Refer to your
Avamar System Administration Guide for additional informa-
tion about editing schedule properties.
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9. Click Next.

The next New Group wizard screen appears.

This screen is used to select a retention policy for use with this group.

10.Select a retention policy from the Select an Existing Retention Policy 
drop-down list.

NOTE:  Retention policies are not modifiable from this
screen. Detailed retention policy properties are shown so
that you can review them prior to making your selection.
Refer to your Avamar System Administration Guide for addi-
tional information about editing retention policy properties.
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11.Click Next.

The final New Group wizard screen appears.

This screen is used to build a list of clients that will be members of this 
group. In this case, our group will contain only one client — the storage 
device client instance.

12.Select the storage device client.

TIP:  Clicking Select All selects all clients; clicking Clear All
deselects all clients (opposite of Select All).

13.Click Finish.

The New Group wizard closes and the new group appears in the Policy 
window.
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Enabling Scheduled Backups

1. Start Avamar Administrator.

2. Select Navigation > Policy or click the Policy launcher button.

The Policy window appears.

3. Click the Policy Management tab.

4. Click the Groups tab.

5. Select the group you created in the previous procedure (the group that 
now contains only your storage device).

6. Select Actions > Group > Disable Group.

This unsets the Disable Group option on the Actions > Group menu.

A confirmation message appears.

7. Click Yes to enable this group.
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Important Terms and Concepts
Plug-in options provide additional control of backups and restores. These options 
are context-sensitive to both the operation being performed and the specific plug-
in selected for that operation.

These options can be specified during on-demand backup and restore operations, 
or persistently set within datasets for all future scheduled backups.

Backup or restore option dialog boxes automatically appear when initiating on-
demand backups or restores, respectively.

When creating a new dataset, the new dataset wizard offers an opportunity to 
configure persistent backup plug-in option settings for that dataset.

To view or set plug-in options for an existing dataset: 

1. Start Avamar Administrator.

2. Select Tools > Manage Datasets…

The Manage All Datasets window appears.

3. Select a dataset from the list and click Edit. 

The Edit Dataset dialog box appears.

4. Click the Options tab.

Plug-in options can be set two ways:

• By using the graphical controls
• By typing option names and values as free text

Setting Plug-in Options by Using Graphical Controls. By clicking the 
Options tab and selecting a plug-in you can display all current options for that 
specific plug-in. 

These settings are represented by graphical controls (for example, options, radio 
buttons, list boxes, and so forth).
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The advantage to setting plug-in options by using graphical controls is that you 
cannot type an option name or value incorrectly. Only valid states are shown.

Setting Show Advanced Options expands this list even further by displaying 
options that are normally only of interest to persons debugging an Avamar 
system. These advanced options are shown in red.

Typing Option Names and Values as Free Text. You can also set plug-in 
options by typing option names and values as free text. 

Clicking More expands the dialog box to include Enter Attribute and Attribute 
Value fields, which can be used to input plug-in options and values as free text. 

However, it must be understood that no error checking or validation is performed 
on these free text entries and that free text entries override settings made by way 
of the graphical controls. 

NDMP Plugin Options
This topic lists and describes the plugin options available for use with any of the 
following Avamar NDMP plugins:

• NDMP
• EMC Celerra via NDMP
• Netapp Filer via NDMP

Backup Options

FIELD/OPTION DESCRIPTION

Filer Dump Mode One of the following:

Prefer Incremental, but do a Full if required

Prefer Incremental, but do a Full if required

Force an incremental (level 1) dump

Save file/directory 
permissions(ACL's) 
with the backup

If selected, extended file and directory Access 
Control Lists (ACLs) are saved during the backup. 
This is the default setting.
NOTE:  This option is not available for use with the 
EMC Celerra via NDMP plugin.
IMPORTANT:  Unsetting this option prevents the 
Avamar server from saving ACLs during your 
backup. You will therefore not be able to restore 
ACLs at any future time.
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Restore Options

FIELD/OPTION DESCRIPTION

Restore file/directory 
permissions(ACL's) 
that were saved with 
the backup

If selected, ACLs saved during NDMP backups are 
restored. 
NOTE:  This option is not available for use with the 
EMC Celerra via NDMP plugin.
IMPORTANT:  If ACLs were not saved during the 
NDMP backup, they cannot be restored.
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avndmp is the script that actually performs an NDMP backup or restore. 

This information is provided for reference purposes only. Inexperienced personnel 
should not invoke this script directly. Contact EMC Technical Support for additional 
information.

avndmp {--backup | --browse | --check-filer-version
 | --check-ndmp-enabled | --restore}

 [--acceladdr=ACCELERATOR] [--advanced_options="FLAGS"]
 [--allowsubvolumeincremental] [--avamar-account-path=PATH]
 [--avtarflags="OPTIONS"] [--avtarport=PORT] [--check-password]
 [--debug] --fileraddr=FILER [--filerpswd=PASSWORD]
 [--filertype={md5 | text}] [--fileruser=USER] [--full]
 [--incremental] --labelnum=NUM [--logfile=FILE] [--prefix=STRING]
 [--restoretarget=PATH] [--snappath=PATH] [--version]

Commands

One (and only one) of the following commands must be supplied on each 
command line: 

Options

--backup Backs up an NDMP filer.

--browse Browses NDMP filer for available volumes.

--check-filer-version Returns specific version of NetApp software.

--check-ndmp-enabled Returns status of NDMP services on the filer.

--restore Restores an NDMP filer.

--acceladdr=ACCELERATOR Specifies IP address or DNS name of the 
Avamar NDMP Accelerator.

--advanced_options="FLAGS" List of advanced options from work order.
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--allowsubvolumeincremental Used with --backup to force incremental 
backups of target subdirectories. 

--avamar-account-path=PATH Specifies a user location (PATH) in the 
Avamar server. Derived from work order.

--avtarflags="OPTIONS" OPTIONS from work order that are passed to 
avtar. Enclose OPTIONS in double-quotes 
and separate multiple options with white 
space.

--avtarport=PORT PORT avtar uses to communicate with 
avagent. Derived from work order.

--check-password If supplied, the ndmjob -q command will be 
issued in order to validate the user name 
and password on the storage device. 
It will not print anything if the password is 
valid, and will print an error and exit with 
error status if it is not.

--debug Enables debug mode, which prints messages 
programmers can use to debug script 
execution.

--fileraddr=FILER Specifies IP address or DNS name of the 
NDMP FILER.
This option is required for all commands.

--filerpswd=PASSWORD PASSWORD for the --id=fileruser 
account.

--filertype={md5 | text} Specifies filer authentication method to be 
either md5 or text when logging in with the 
--id=fileruser account.

--fileruser=USER NDMP filer log-in account.

--full Used with --backup to perform a full backup 
of NDMP filer.

--incremental Used with --backup to perform an 
incremental backup of NDMP filer. This is the 
default backup mode.

--labelnum=NUM Used with --restore to select the label 
(sequence) number of the backup to restore. 
This option is required.

--logfile=FILE Logs to this FILE. If no FILE value is 
supplied, default log file (avndmp.log) is 
used. 

--prefix=STRING Prefix this STRING to all log files. This is 
typically the Work order ID (WID). 
Derived from work order.
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avtar NDMP Options

--restoretarget=PATH Used with --restore to specify an 
alternative restore location (other than the 
default location specified by --snappath) on 
the NDMP filer.

--snappath=PATH Used with --backup to specify a location 
(PATH) on NDMP filer to begin backup.
Used with --restore to specify which 
volume to retrieve from the Avamar server 
and the default location on the NDMP file to 
restore it.

--version Shows version, then exits. 

--dumpformat Writes NDMP stream.

--dumplittle Writes NDMP stream with little-endian byte ordering.

--dumpnetapp_acls Writes NDMP stream with NetApp ACLs.
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